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Congratulations on your purchase of Finale 2008 for Windows! 
 
IMPORTANT: Read this document before you begin working with Finale 2008 and print a copy of it to keep with 
your Finale information.  
 
This file contains important information about Finale 2008 not included in the User Manual as well as information 
about converting older files into the new version's format. Please note that Finale 2008 files cannot be opened in 
previous versions of Finale. 
 
This document is organized by each version's changes; those of you already familiar with earlier versions may wish 
to read only the new information. The Read Me contains the following sections: 
 
Running Finale 2008 
New features in Finale 2008 
Fixes in Finale 2008a 
Fixes in Finale 2008 
 
You may also visit our web site, www.finalemusic.com for updated information about Finale and information on 
new releases.  
 

Running Finale 2008 
 
System Requirements 
Windows® XP/Vista. 200MB hard drive space required for software and user manual.  
 
CD-ROM drive. 800x600 minimum monitor resolution. Minimum 256MB RAM (1GB or more recommended for 
optional use of Garritan sounds/KONTAKT™ Player 2: more RAM = more available sounds.) An additional 1.6GB 
hard drive space is required for all Garritan sounds.  
 
Optional:   
MIDI interface. MIDI input and/or playback device. Printer. Scanner. Microphone required for use of MicNotator®. 
A soundcard (including a Standard DirectSound driver) is required for playing the Garritan sounds. 
 
Installing Finale 2008 
If any previous version of Finale has been installed on the machine, Finale 2008 recommends that you restart your 
computer and log on as System Administrator before installing. This will prevent erroneous font warnings. 
 
We recommend that you install Finale, and any other software, when logged in as System Administrator. 
 
If you encounter problems during installation, we recommend that you do the following: 
 

1. Turn off any programs running in the background. Virus detectors can often prevent Finale from installing 
necessary files and updating the registry. Rest assured, your Finale CD does not contain any viruses. 

2. Press Ctrl-Alt-Delete, then click on Task Manager and then the the Process tab. In the Processes Tab, click 
on "User Name" to sort the running programs by user ID name. This lists every process that is running on 
the system. 

3. Under the User Name column, look at all of the processes ("Image Name") with your account name.  Click 
on each one, and then click "End Process" and select OK.  Do this for every process assigned to your name 
except “taskmgr.exe”, “explorer.exe”, and “System Idle Process.” 



4. Close the Task Manager. 
5. Check your system tray (lower-right corner of the screen) to see if any programs are running. Right-click 

each of these and choose Close - especially antivirus software, which does interfere with programs 
properly installing. 

 
Authorizing Finale 2008 
The first time you launch Finale, you will be prompted to authorize. To authorize a single copy of Finale, click 
Authorize Now! to open the Authorization Wizard (or, from the Help Menu, choose Authorize Finale). Then follow 
the instructions to authorize your copy of Finale via the Internet, phone, or mail. If you choose not to authorize, you 
will be prompted to do so each time you launch Finale. If you do not register within thirty days, printing and saving 
are disabled until you choose to authorize. 
 
Note that the User/Authorization Codes are computer specific, and will only work on the given computer 
installation. Make sure that the Authorization Code is typed in using capital letters, and also verify that the correct 
serial number has been entered. Your copy of Finale can be authorized on two computers simultaneously, and, with 
an Internet connection, authorization can be moved from one computer to another at will. Simply choose 
Deauthorize Finale from the Help Menu to open up a free slot. Your copy of Finale can now be authorized on a 
different computer. When you Deauthorize, printing and saving are disabled until authorization has been restored. 
 
If you make a change to the computer (such as replacing the hard drive or motherboard, or installing a new operating 
system), then you will need to re-authorize the installation. If you have already installed and authorized twice, you 
will need to contact Customer Support online at www.finalemusic.com/support with your serial number and the 
location ID for the specific installation in question. If the software is not "reminding" you to authorize when you run 
the program, then the registration/authorization has been successfully completed. 
 
Starting Finale 2008 - DLLs 
Most applications (including MakeMusic products) require a set of files, the Microsoft redistributables, in order to 
work successfully on your system. These redistributable files are normally already present on most systems and are 
not generally included in application setup/install scripts - doing so would add about 1.5 MB to the size of the 
package, and cause a longer installation process. More importantly, as these files are constantly updated by 
Microsoft and are operating-system specific, including these files in an application installer could result in incorrect 
files being added in your system and subsequent problems. 
  
In rare cases these files may be missing or out of date on your system. In this case an error will be reported when 
you start the program. Here are some examples of the errors that could be reported:  
If the files are missing...  
'The dynamic link library MSVCP60.DLL could not be found in the specified path...' 
or  
'The dynamic link library MSVCRT.DLL could not be found in the specified path...' 
If the files are out of date...  
'The OCXTS.EXE file is linked to missing export MFC42.DLL:6880.' 
 
If you see one of these messages, visit www.microsoft.com for more information regarding these files and how to 
restore them. 
  
User Manual 
For full documentation on how to use Finale 2008, see the User Manual. To access the User Manual, choose the 
Help menu, then User Manual, then Table Of Contents. 
 
Interface Changes 
Finale is easier to learn and use than ever with more universal editing control. As a result, there are many changes to 
Finale interface such as an enhanced Selection Tool (which replaces the old Mass Edit Tool), and a new unchanging 
“Utilities” menu. For details, from the Help Menu, choose User Manual, then Table Of Contents. Then click “Finale 
2008 Interface Changes.” 
 
Vista and Exporting EPS Graphics 



Windows Vista uses a new True Type font format that is not compatible with Finale’s EPS export mechanism. As a 
result, Vista users will notice the "Include Fonts" check boxes have been removed in the Export Selection and 
Export Pages dialog boxes. Including fonts in exported EPS graphics is still fully supported in Windows XP. 
 
Default View 
Studio View, Finale’s view optimized for auditioning playback, is set as the default view. To change the default 
view to Page View or Scroll View, from the Edit Menu, choose Program Options and select the New page. Choose 
the desired default view and click OK.  
 
Playing QuickTime Videos in Finale's Movie Window 
To play QuickTime videos in Finale for Windows, QuickTime (a free download at www.apple.com) must be 
installed on your computer. Movie files saved in Windows Media Player formats do not require QuickTime. 
 
Sharing Finale Documents Online 
Finale NotePad provides a free, reliable, and easy way to view and playback Finale documents downloaded from the 
Internet. To open a Finale (MUS) file available at Finale Showcase, or another online resource, viewers now need to 
simply download the file to their local machine and then open it in Finale NotePad. This means all Finale files 
posted on the Internet will be available for viewing on all machines immediately upon the release of Finale NotePad 
2008. Finale NotePad is available for download free of charge at www.finalemusic.com/notepad. (Note that 
documents saved in Finale 2008 are only compatible with NotePad 2008, which becomes available shortly after the 
Finale 2008 release. NotePad 2008 will open files saved in any Finale version 2008 or earlier.)  
 
Contacting Customer Support 
For Finale support, visit http://support.makemusic.com. 
 
Converting Finale 2007 (and earlier) documents into Finale 2008 documents 
Finale 2008 has a different file format than earlier versions, and converts older files to the new format when you 
open them in Finale 2008. Finale 2008 will open and convert older versions' documents, giving them the default title 
"UNTITLED.MUS." We recommend saving a newly converted document with a different name than the original 
file, keeping the older unconverted file as a backup. If you do want to save the file using the same name, choose 
Save As from the File menu. Finale displays the original file name, so you can click OK to rewrite over the old file. 
 
Running older versions of Finale 
Finale 2007 (and earlier versions) for Windows or Macintosh cannot open any standard Finale 2008 file. To open a 
Finale 2008 document in an earlier version, save the file in MusicXML format and then open the MusicXML file 
using the MusicXML Import plug-in. Finale for Windows includes the MusicXML importer back to version 2003, 
and then back to 2000 using software available separately. Finale for Macintosh supports Music XML import back 
to version 2004 (OS X only) using software available separately. See www.recordare.com/finale.  

 
New Features in Finale 2008a 
 

In files using VST instruments, audio files are no longer saved in real-time. The process is now quicker on 
fast machines, and slower machines will now produce better-sounding results. 

Time Signatures can now be excluded when copying stacks. 

Human Playback Improvements to performance, instrument techniques, and more. 

Measure settings can now be copied when either the source or target constitutes a stack.  

 
New Features in Finale 2008 
 



Interface Enhancements offer a streamlined work environment with less switching tools and more universal 
menu commands specifically designed to help you finish projects faster. For a detailed list of all the changes, 
see Finale 2008 Interface Changes. 

A Powerful New Selection Tool  has inherited all the functionality of the expired Mass Edit Tool. 
Adapted for selecting measure regions, the Selection Tool is now Finale's universal editing utility.  

Cut, Copy, Paste, and Insert Improvements allow unprecedented flexibility when choosing how, what, and 
where to copy. Plus, consistent results whether drag-copying or using the clipboard, even between documents.  

Add An Audio Track to your score by either importing an audio file or recording a live performance with 
HyperScribe.  

New Garritan Sounds including saxophone, guitar, jazz bass, choir, marching percussion and many more.  

Human Playback updates provide even more support for Garritan products and Kontakt Player 2 as well as 
additional Instrument Techniques and an enhanced dictionary. 

Playback using Garritan and SoundFont instruments simultaneously. 

HyperScribe improvements allow you to easily record first and second endings and offer more control of the 
recording tempo.  

Vista support allows you to install, register, and run Finale on Microsoft’s latest operating system. 

Boomwhackers® Tuned Percussion Tubes / Chroma-Notes™ Instruments - Ready with colored noteheads 
and an accompanying SoundFont.  

Document Styles allow you to formulate a custom medley of libraries and document settings, or choose from 
one of Finale's offerings, for integration with the instrumentation of your choice in the Setup Wizard. 

Customize templates when you open them using the last two pages of the Setup Wizard.  

Improved Scanning with XML technology means better recognition. Also, you can now acquire sheet music 
directly from your scanner. 

Expanded MusicXML import and export including support for fretboards, stem direction, engraver slurs, 
piano pedals and more. 

More Text Inserts including "Arranger," "Lyricist," and "Subtitle." These are recorded in Finale's New 
File Info dialog box and can also be defined in Finale 2008's redesigned Setup Wizard.  

Expanded Setup Wizard Options allow you to select a Document Style, assign Document Styles to specific 
ensembles, and add additional score information including Arranger, Lyricist, and Subtitle.  

Merge Multiple Scores automatically using the Score Merger. Consolidate multiple movements horizontally 
into a single document or merge a collection of parts vertically into a full conductor's score.  

Customize Zoom Percentages as you wish them to appear in the View Menu. 

Updated Documentation provides the information you need quickly and easily. Finale's new User Manual 
features improved navigation, context-sensitivity, and an interactive Visual Index.  

 

Fixes in Finale 2008a 
 
Audio 
• Adding a new staff to the top of a score no longer removes the existing audio track without warning. 
• Recording/Importing of audio now takes pickup measures into account for the start point. 
• The audio track no longer disappears if a measure is inserted before a repeat where an audio track is set to play 

on the nth pass. 
• The audio hyperscribe block is no longer temporarily erased by the cursor during repeats of the passage. 
  



Chord Tool 
• The plus sign now works properly in chord suffix creation. 
• Chord Suffix IDs are no longer corrupted in some files when copying chord symbols. 
 
Clef Tool 
• If a pickup measure is included in the selected region, changing the clef no longer results in a mid-measure clef. 
 
Copy/Paste 
• Extra notes are no longer added to the target region when drag copying in certain documents. 
• Drag-copying MIDI Tempo data in the MIDI Tool now works properly. 
• Manual changes to measure numbers in the target region are no longer improperly overwritten on paste. 
• Whenever barlines are copied, the states of the following Measure Attributes are now also copied: "Break a 

Multimeasure Rest," "Break Smart Word Extensions," and "Override Group Barlines." 
• When inserting a non-stack selection with "Notes and Rests" unchecked in the Edit Filter dialog box, rests that 

are inserted are considered and the music is rebarred accordingly preventing overfilled measures. 
• Expressions in staff lists no longer occasionally disappear from the source region after copying. 
• Copying and pasting no longer causes redundant accidentals or naturals to appear in the target region. 
• The custom Arrowhead for Smart Shapes is no longer left off when Smart Shapes that use custom arrowheads 

are copied. 
• Redundant accidentals or naturals (that are already part of the key signature) no longer appear in the target 

region while pasting 
• When a partial measure is selected in all staves, pressing Shift-up/down arrow no longer subtracts from the 

selection in only one direction. 
• If a measure plus an eighth note in the previous measure is highlighted, it can now be drag-pasted to all possible 

beats of an empty measure. 
• When copying with a filter only checked items are overwritten in the target region. 
• Tablature string alterations are now retained when copying and pasting. 
• Performance of paste operations with attachments such as measure expressions has been improved. 
• Note attached items like Slurs, lyrics, note expressions and chords are now properly copied when you use a 

filter. 
• Copying passages without stack selection is no longer slower than copying in previous Finale versions. 
• It is no longer difficult or impossible to paste music into a region that starts with a pickup measure. 
• Tie alterations now copy correctly even without Dot Alterations checked in the Edit Filter dialog box. 
• Copying with a Filter no longer causes "Slur" to become improperly unchecked in Edit Frame dialog. 
 
File Menu 
• When multiple files are open, Finale no longer crashes after closing the 1st open document in the list and then 

changing layers in one of the remaining open documents. 
• The presence of tempo data in some files saved in Finale 2008 no longer cause silent notes. (Finale 2008a 

automatically checks and resolves this when a Finale 2008 file is opened). 
• Finale no longer crashes when importing some MIDI files. 
• Tempo data is now accurate in saved MIDI files. 
• Inserting measures in front of a measure containing an expression assigned to a Staff List with Top 

Staff checked no longer duplicates the expression. 
• Copying notes that contain articulations no longer duplicates the articulation in the Articulation Selection dialog 

box in the default music font.  
• There is no longer an unsightly line break in Save/Print disabled warning message on Windows Vista. 
 
Edit Menu 
• The switch between Play Through MIDI and Play Through AU can now be undone under the Edit Menu. 
• The Edit Menu no longer displays incorrect keyboard shortcuts for Clip Files (Cut, Copy, Insert and Paste). 
• The Undo list no longer refers to the Audio Track as a Staff. 
 
Expression Tool 



• Note-attached Expressions no longer draw at incorrect sizes when added at percentages other than 100% in 
Scroll and Studio view. 

 
FinaleScript 
• Help buttons have been added to the FinaleScript dialog boxes. 
• Batch processing open documents is no longer erratic. 
• Calling plug-ins from a script now functions properly 
• Menu item commands with hierarchy (e.g. menu item "document/page format/score") now works with a slash '/' 

and semicolon ':' 
• Save as MIDI now functions properly. 
• The Swap font/font search and replace results are not visible immediately on-screen. 
• Search/Replace File Info now functions properly. 
• Search and Replace now supports the following additional attributes: articulations, group names, subtitle, 

composer, arranger, and lyricist. 
• The ‘staff height’ and 'system size [x]%' commands no longer hang Finale. 
 
Graphics Tool 
• Final barlines no longer print out as thick double barlines when exported as an EPS. 
• File size no longer increases after adding then deleting embedded graphics. 
• EPS graphics exported from Finale under Windows Vista can now be opened in GSview. 
• Redo of an embedded graphic placement no longer leads to a crash. 
 
Human Playback 
• All Human Playback dialog boxes now include help buttons. 
• Performance and stability improvements. 
• Playing back with some Staff Set selected no longer cause a hang. 
 
Linked Parts 
• Enharmonics are no longer incorrect in certain files when a voiced part is extracted. 
 
Lyrics 
• Hyphens are no longer improperly placed over system breaks.  
• Missing hyphens in tightly spaced lyrics now display properly. Hyphens that have disappeared in older files 

(Finale 2006 and earlier) have been restored. 
 
Measure Menu 
• Clear Measure Number Positioning & Enclosures no longer function when unchecked. 
 
MIDI Menu 
• When a file setup to use Softsynth is opened with no softsynth_vst.dll available, Finale now reports the error. 
 
MIDI Tool 
• Drag-copying MIDI Tempo data in the MIDI Tool is now possible. 
• Scaling tempo by percentage in addition to absolute values now works correctly. 
 
Mixer 
• The volume control mixer links now work in Vista. 
 
MusicXML 
• Exported MusicXML files with font changes in lyrics import correctly.  
 
Native Instruments VST 
• When opening files across platform that have the SoftSynth VST/AU plug-in loaded, Finale now automatically 

loads the equivalent plug-in. 



 
Palettes and Backgrounds 
• The icons for the Tuplet and Smart Shape Tools are correct upon selection in the Cool Black palette. 
 
Playback 
• When clicking outside a staff to initiate playback Finale no longer freezes. 
• During scrolling playback, the playback cursor no longer extends down to include hidden staves. 
• Tempos, edited through Tempo Tap, are now more accurate upon playback allowing for better synchronization 

with imported audio files. 
• Adding new SmartMusic SoftSynth staves with the Setup Wizard to a non-VST file no longer silences the 

previous staves. 
 
Repeat Tool 
• Repeat ending staff list settings are now applied to both brackets when creating endings. 
 
ScoreMerger 
• Help buttons have been added to the Instrument Junction and Edit Junction dialog boxes. 
• The Merge These Files into One File command now provides improved automatic instrument linkage. 
• Non-copyable staff styles are now copyied. 
• Stability improvements. 
• The Parts to Score command includes improved layout if the first file has optimized systems. 
• Copying from the report dialog box is now possible. 
 
Selection Tool 
• Selected measure numbers are now hidden when pressing Delete. 
• Measure highlighting now disappears when deleting measures with the context menu. 
• Deleting measures on the last page of a document no longer causes the document to jump to page 1. It now 

jumps to the previous page as expected. 
 
Setup Wizard 
• It is now possible to use the up arrow for Ensemble selection. 
 
Simple Entry Tool 
• "Note details" no longer remain when notes are deleted. 
 
SmartMusic 
• The Create SmartMusic Assessment Wizard no longer sets up incorrect keys for transposing instruments. 
 
Speedy Entry 
• Pressing Ctrl-1, Ctrl-2, or Ctrl-3 in Speedy Entry (using the number row above the QWERTY keys) no longer 

exits the Speedy Frame and accesses the custom view percentages rather than defining tuplets. 
• Note IDs for rests are no longer changed by looking at them with the Edit Frame Attributes dialog box. 
• Changing the pitch of an existing enharmonically flipped note no longer erroneously flips the enharmonic of the 

changed pitch. 
• Ctrl-L now sets the stem direction back to the default automatic direction. 
 
Staff Tool 
• After double clicking a Staff Style bar in scroll view, a staff is no longer added after exiting the Staff Style 

dialog. 
 
Text Search and Replace 
• Help buttons have been added to the Text Search and Replace dialog box. 
• File Info support now functions properly. 
• Articulations and group name characters can now be searched and replaced 



 
Time Signature Tool 
• Context-menu time signature changes are now applied correctly to measures with independent time signature 

staff styles. 
• Time Signatures can now be changed when Independent Key Signatures is turned on. 
 
Text Tool 
• Upper ASCII characters in the Score Name text insert are now converted correctly when opened across 

platforms. 
• Upper ASCII for Description and Score Name text inserts are now converted correctly when opened across 

platform. 
• Text Blocks using a custom frame no longer have a bounding box that is too big. 
 
Utilities Menu 
• Rebar Music now breaks whole notes into smaller durations when the time signature is too large for whole 

notes. 
• File Maintenance now cleans up out of order tempo data. 
• Chords with flipped enharmonics are no longer improperly transcribed using Explode Music. 
 
View Menu 
• Programming a Staff Set is now possible in Studio View. 
• Bookmarks that include staff list settings now switch to the staff list when called. 
 
Window Menu 
• The File menu toolbar no longer displays the scanning icon as "1" In the Customize Toolbars box instead of 

"Import Scanned Music File." 

 
Fixes in Finale 2008 
 
Chords 
• Articulations are no longer substituted when pasting to a destination document with fewer staves. 
 
Clef Tool 
• When clefs are set to never copy, clef changes at the destination are no longer cleared. 
• Clefs now shift when inserting music with a regional selection. 
 
Copy/Paste 
• Custom barlines now copy across documents when they are not defined in the target document. 
• Entries are no longer pasted/inserted even if unchecked in Items to Copy (now “Edit Filter”) dialog box. 
• The ESC key now cancels all copy operations. 
• Empty measures that are only partially selected are no longer treated like whole measures on paste/insert. 
• Finale no longer rebars music if the destination start point in the measure is the same as source's. 
• Paste and Insert menu items no longer appear enabled even if nothing is on the clipboard. 
• All Stave Expressions will now paste if there is already a Measure Expression in the target region. 
• Finale no longer crashes after copying and pasting/inserting (drag or clipboard) into a measure with a time 

signature of x/1. 
• Secondary beam breaks can now be copied with a regional selection. 
• Real whole rests in measures with time signatures less than 4 beats are no longer renotated when copied with 

regional selection. 
• Note attached Smart Shapes in the pasted region can now be copied to a new location after copying with a filter 

which doesn't include the Entries themselves. 
 
Edit Menu 



• The default settings for Import MIDI from Clipbaord have been updated - "Continuous Data" is now checked 
and "Tempo Changes" is unchecked. 

 
Exercise Wizard 
• Clicking the Up/Down arrows on page 2 to reorder the list of exercises no longer causes them to be duplicated.  
 
Graphics Tool 
• The "Tiff resolution" setting is now retained within a single session. 
 
HyperScribe 
• HyperScribe recordings no longer fail to load VST/AU instruments resulting in silent countoff. 
 
Human Playback™ 
• Human Playback now sends pizz/arco key switches to Full Strings KS. 
• Entering a fermata from the Articulation Tool to a grace note no longer hangs Human Playback. 
• Slurs no longer trigger the 'Tpt: Stand. (GM)' technique, which is in turn triggers the Staff’s Patch. 
• Kontakt 3 support. 
 
Linked Parts 
• Pages are now updated prior to printing to account for automatic changes to multimeasure rests. 
 
Lyrics Tool 
• If Lyrics is unchecked in the Edit Filter dialog box, they will no longer be added to the Edit Lyrics window after 

pasting/inserting. 
 
Measure Tool 
• Hiding a measure number no longer makes all measure handles disappear. 
• Measure numbers no longer always revert to their default placement when an item is cleared. 
 
Metatools 
• The informational metatool warning message "Use the shift key now to program metatools rather than the 

control key. You can now program metatools on all the alphabet keys (A-Z) as well as the number keys" has 
been removed. 

 
MIDI Tool 
• Opening the MIDI Tool split-window and selecting the handles on notes no longer causes data for some notes to 

disappear (Windows Vista). 
• Randomize now functions properly rather than subtracting the duration entered. 
• Hiding a measure number no longer makes all measure handles disappear. 
 
Native Instruments VST 
• The Play Through VST check mark is no longer lost if a file is saved without playing. 
 
Pickup measures 
• Pickup measures are no longer treated like full measures while copying. 
• Copying notes into a pickup measure no longer results overfilling or turning into a full measure. 
 
Playback 
• Windows Vista no longer stops responding after starting playback by spacebar clicking a measure. 
• Context clicking a staff using Independent Key Signatures and choosing a key no longer affects the other staves. 
 
Program Options 
• The tab order in the Interface Colors section of the Display Colors section of Program Options is no longer 

incorrect. 



 
Quantization 
• The Allow Dotted Rests option is now dependent on time signature (More Quantization Settings). 
 
Redraw 
• Music no longer disappears in the active window while scrolling when “Redraw Only the Active Window” is 

checked. 
 
Repeat Tool 
• The behavior of the delete and clear keys is now standard. 
 
Simple Entry 
• The keymaps.txt file is now generated properly. 
 
Staff Tool 
• Percussion maps can now be moved and deleted – rather than just the name of the map. 
• Dragging a staff handle no longer leaves a duplicate artifact of the handle behind if there is a Staff Style bar 

showing. 
 
Selection 
• After selecting all or a region, context clicking a measure in an optimized system no longer deselects all but that 

measure. 
• Carriage returns can now be used to create line breaks when entering long copyright inserts. 
 
Text Tool 
• Carriage returns can now be used to create line breaks when entering long copyright, composer, arranger, 

lyricist, and subtitle inserts. 
 
 
 
 

 

 

 


